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This lab is categorized into 4 parts.
1. Setting up the Hypervisor server (ESXi) and creating VMs- Centos and Windows Server 2012.
2. Network configuration of eNB
3. Installation of Required Software for the eNB interfacing.
4. Commissioning the eNB.


1. a) Setting up the Hypervisor Server

Collect the blank Hard-disks from the Professor. This will be the storage for the EPC, ESXi and other software that will be installed in the subsequent steps.

In the DLC 1B20 Lab, kindly use SOC 4 (team-1) and SOC 5 (team-2) servers.  First the hypervisor software needs to be installed and the link for same can be found below:
https://my.vmware.com/en/web/vmware/evalcenter?p=free-esxi6 
Please burn the software into a DVD, so that you can use the same in the server.

During the boot process, make sure that both the Hard-drives that you inserted are powered on as shown below:
[image: ]

Go into the boot manager and make the server boot from the ESXi software that you downloaded. 

Give the default username as “root” and password as “password”. This is just to maintain an uniformity among the servers.

Note down the IP address that the server gets. This is the IP address that you need to browse into, for creating VMs.
[image: ]

b) Creating the VMs

   Once you are in the browser window of the server, go to     Storage and create a new datastore. VMs are created in the datastore. We will be using a single datastore for both the VMs.

Once the datastore is created, import the image file of Windows Server 2012 R2 (64 bit) version. 

Next, go to Virtual Machines and create a new VM.
[image: ]

Now make the VM point to the image that you uploaded and start the installation.



2. Network configuration of eNB

Switch on the eNB and wait for a static green light in the back. Once stable, console into it.

Username: root
Password: air4best

Check if you are able to console into the eNB with the default baud rate. If not, try increasing it.

Once you are in the shell, check the ip address of the eNB. There might be multiple interfaces and each might have its own IP. To actually check which eth interface you are connected to, refer to the mac address of the NIC below the eNB.  

Disable the other eth interfaces. Change the IP of the connected interface to “192.168.1.71”.  Now reboot the eNB.

Now check for the IP again and verify if the changes that you made are saved. The shell takes up the default ip of the interface from “/bsdata/ipaddr” and hence, this time make the modifications in this file. 

If you are not able to disable the other eth interfaces, then assign them a static IP in a different subnet in the same file. This is to ensure that you are not confused about the eth interface which is being connected to.

Paste a screenshot of the file after your modification.

Again reboot and check the Ip address. Are the changes reflecting? Please paste a screen shot of the addresses after the change.

Now ping to the computer that the eNB is attached to. Make sure that both are in the same subnet.

Please attach a screen shot of the ICMP message to the eNB and from the eNB.

This ensures that the eNB is assigned a static IP and is part of the same subnet as the EPC, which will be configured in the subsequent steps.

3. Installing the required software on Windows R2 server

There are 3 main software to be installed on windows:
· Netspan
· SQL Express (64 bit)
· Web server (IIS)

But for Netspan to be installed, web server (IIS) and SQL server need to be installed. 

Server manager is a built-in feature of windows server which is used to configure IIS.

Also, few options in the software installation may not be exactly as mentioned in the manual, but it gives an outline of the process.

Installation guide for IIS:




SQL Express software is free to download from Microsoft website. (just search for sql express 2014) 

Installation guide for SQL:



(note: when you are in the database engine configuration page in the manual, follow the manual procedure and click on ‘add current user’ instead of ‘add user’)

Installation of Netspan:
The installation file will be on the website

Extract the file and run the setup.

When you see the screen below:
[image: ]
Select the database server that you selected during IIS configuration (the server from the server pool). If you see server name with WIN/… it is referring to your local machine. Since you selected server from the server pool, please select the other server name.
 
Login: sa
Password: (the password that you provided in the database engine configuration during SQL installation) 

And you should see the Netspan installing.
 
After it is installed, you can access the Netspan web GUI by going to http://localhost/Netspan/startup/login.aspx from the VM. 



Login credentials:

Username: admin
	Password: password
	
And you should be able to login to the netspan management UI.
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 About this Guide 
1.1 Purpose 
This guide describes the procedures required for installing IIS. It covers the following areas: 


¾ Installing IIS 
¾ How to Enable SSL for Netspan on IIS 7 (Windows Server 2008 and Windows 7) 
¾ How to Enable SSL for Netspan on IIS 8.5 (Windows Server 2012 R2 and Windows 8.1) 
¾ Preventing browser warnings caused by self-signed certificates 
 


  
Note:  This guide contains significant information required for completing the 
initial Netspan installation. 


 


1.2 Intended Audience 
This guide is for the personnel who are responsible for installing IIS. Airspan assumes that you are 
qualified in performing installations and have a basic working knowledge of IIS. 


1.3 Conventions 
This document uses the following informational conventions. 


Icon Description  


 


 
Checkpoint:  Marks a point in the workflow where there may be an exit or branch 
to some other procedure.  At each Checkpoint the reason for an exit or branch is 
given along with specific directions to locate the entry point in the other 
procedure. 


 


 
Reference:  Gives a resource in the workflow that may be needed to complete a 
procedure along with specific directions to use the resource. 


 
Caution:  Describes a possible risk and how to lessen or avoid the risk. 


 


Advice:  Provides a recommendation based on best practice. 


  
Note:  Provides useful information. 


 


1.4 Referenced Documentation 
The following documents contain related information: 


x UGD-D00131 - Netspan Installation and Upgrade Guide 
This guide provides instructions on how to install Netspan. 


x UGD-D00644 - Netspan SQL Server 2008 R2 Express Installation Guide  
This guide provides instructions on how to install SQL Server 2008 R2 Express. 


x UGD-D00677 - Netspan SQL Server 2008 R2 Standard Installation Guide 
This guide provides instructions on how to install SQL Server 2008 R2 Standard. 


x UGD-D00733 - Netspan SQL Server 2012 Express Installation Guide 
This guide provides instructions on how to install SQL Server 2012 Express. 
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x UGD-D00737 - Netspan SQL Server 2012 Standard Installation Guide  
This guide provides instructions on how to install SQL Server 2012 Standard. 


x UGD-D00738 - Netspan SQL Server 2014 Express Installation Guide  
This guide provides instructions on how to install SQL Server 2014 Express.  


x UGD-D00739 - Netspan SQL Server 2014 Standard Installation Guide  
This guide provides instructions on how to install SQL Server 2014 Standard. 


1.5 Organisation of This Guide 
This guide is organised into the following sections: 


¾ About this Guide 
¾ Installing IIS 
¾ How to Enable SSL for Netspan on IIS 7 (Windows Server 2008 and Windows 7) 
¾ How to Enable SSL for Netspan on IIS 8.5 (Windows Server 2012 R2 and Windows 8.1) 
¾ Appendixes 
¾ Revision History 
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2 Installing IIS 
 


This section provides instructions for installing IIS on Windows OS. Based on the OS that you have 
installed, select one of the following installation procedures that is appropriate for you: 


x Install IIS on Windows 2008 Server and Windows Server 2008 R2 
x Install IIS on Windows Server 2012 and Windows Server 2012 R2 
x Install IIS on Windows 7 
x Install IIS on Windows 8 


 


  


Note: For information on the prerequisites, permissions, and user role that are 
required to perform this installation, see Netspan Installation and Upgrade Guide 
(UGD-D00131). 


 


2.1 Install IIS on Windows 2008 Server and Windows Server 2008 R2 
1. Select Roles. 
2. Normally Windows 2008 Server starts user login session with Initial Configuration Tasks 


window.  
If this is disabled, launch the Server Manager from the Start menu (by selecting 
Administrative Tools -> Server Manager). Then right-click on Web Server (IIS) option (see 
screenshot below) and select “Add Role Services”. 


 
Figure 1 - Server Manager 
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Figure 2 - Installation Configuration Tasks 
 


3. Add Roles Wizard 
Read “Before You Begin” note and press Next. 


4. Select Server Roles 
Select Application Server and Web Server (IIS) roles. 


 


 
Figure 3 - Select Server Roles 
 


5. When Application Server is selected confirm the message box – press Add Required 
Features. 


6. Application Server 
Read the information note and press Next. 
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7. Select Role Services for Application Server 
Select the following services for Application Server: Application Server Foundation, Web 
Server (IIS) Support, HTTP Activation (required for Web Services). 


 
Figure 4 - Select Role Services 
 


8. When Web Server (IIS) is selected confirm the message box – press Add Required Role 
Services. 


9. Web Server (IIS)  
Read the information note and press Next.  


10. Select Role Services for Web Server (IIS) 
In addition to the services selected by default enable IIS6 management Compatibility option. 
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Figure 5 - Role Services 
 


11. Confirm Installation Selections 
Verify all the options selected and press Install. 


12. Installation Progress: Wait for the installation to complete. 
13. Results: Following Installation, check the installation results and verify that the installation has 


succeeded. Reboot the server if requested by the installer 







 Netspan IIS Installation and Configuration Guide  


 
Page 12 Commercial in Confidence UGD-D00643 Rev F 


 
Figure 6 - Results 
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2.2 Install IIS on Windows Server 2012 and Windows Server 2012 R2 
1. Start the Server Manager. 


 
Figure 7 - Server Manager – Dashboard 
 


2. From the Quick Start menu, select Add roles and features. 
3. Before you begin - after reading the notes, click Next. 
4. Select installation type - select Role-based or feature-based installation and click Next. 


 
Figure 8 – Server Manager – Installation Type 
 


5. Select destination server - select option Select a server from the server pool and click Next. 
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Figure 9 – Server Manager – Server Selection 
 


6. From Select server roles, check the Application Server and Web Server (IIS) checkbox and 
click Next. 


 
Figure 10 – Server Manager – Server Roles 
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7. In the Features selection window, select the following options and click Next. (For all the other 
options in this window, keep the defaults offered). 


 
Figure 11 – Server Manager – Features 
 


8. In the Web Server Role (IIS) window, click Next. 
9. In the Web Server Role (IIS) Role Services window, select the following options and click 


Next. 
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Figure 12 - Server Manager –Web Server Role (IIS)  Role Services 
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Figure 13 – Server Manager –Web Server Role (IIS)  Role Services Cont. 
 


10. In the Applications Server window, click Next. 
11. In Application Server Role Services window, select the following options and click Next. 
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Figure 14 – Server Manager – Application Server Role Services 
 


12. Confirmation window - select Install and wait for the installation to complete, which will take 
several minutes. 


13. Results window – Close the window after installation is completed. 


 
Figure 15 - Server Manager - Results window 
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2.3 Install IIS on Windows 7 
1. In the Start menu, type add or remove programs, and then select that option. 
2. From the resulting dialogue, select “Turn Windows features on or off” from the options on the 


left. 
 


 
Figure 16 - Turn Windows features on or off 


 


3. From the resulting dialogue, select “Microsoft .NET Framework 3.5.1” and “Internet 
Information Services” and ensure that the options shown in the screenshots below are 
enabled. 


 
Figure 17 - Selecting Microsoft .NET Framework 3.5.1 
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Figure 18 - Selecting features 


2.4 Install IIS on Windows 8 
1. Open Control Panel. 
2. Select Programs and Features. 
3. Select Turn Windows features on or off. 
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Figure 19 – Programs and Features Window 


In the ensuing window, make sure you enable the options shown in Figure 20. 


 


Figure 20 – Selecting features 


4. Click OK. 
5. If Windows needs files from Windows Update to finish installing some features, select 


Download files from Windows Update. 
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Figure 21 – Windows Features 


6. When Windows completes the requested changes, click Close. 


 
Figure 22 – Completing the IIS Installation 
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3 Enabling SSL for Netspan 
This section provides instructions for enabling SSL for Netspan. Based on the OS that you have 
installed, select one of the following installation procedures that is appropriate for you: 


x How to Enable SSL for Netspan on IIS7 (Windows Server 2008 and Windows 7) 


x How to Enable SSL for Netspan on IIS8.5 (Windows Server 2012 R2 and Windows 8.1) 


3.1 How to Enable SSL for Netspan on IIS 7 (Windows Server 2008 and 
Windows 7) 


3.1.1 Adding a Security Certificate 
1. Start Internet Information Services (IIS) Manager and select the server in the list of 


Connections. 
 


 
 


2. Select and run (double click) Server Certificates 
 


 
Figure 24 – Add a Security Certificate 


Figure 23 – Select the server 
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3. Add a certificate using the options in the Actions pane.  In this example Create Self-Signed 
Certificate is used.  


 
Figure 25 - Specify name 
 


4. Give the certificate a name and select OK 
 


 
Figure 26 - Server Certificate 
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3.1.2 Adding an HTTPS Binding 
1. Start Internet Information Services (IIS) Manager and select Default Web Site. 


 


 
Figure 27 - Default Web Site 


2. Select Bindings… 
 


 
Figure 28 - Add Site Binding 
 


3. Click Add.., change Type to https and select the SSL certificate that was added previously. 
Click OK and then Close. 
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3.1.3 Accessing Netspan via SSL 
1. Use https://<server>/Netspan where <server> is the full server name. 


 


 
Figure 29 - Via SSL 


3.1.4 Forcing all Connections to Use SSL 
These instructions may be used to disable http access to Netspan and force use of SSL via https. 


1. Start Internet Information Services (IIS) Manager and select Default Web Site. 


 
Figure 30 - Default Web Site 
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2. Select SSL Settings. 
 


 
Figure 31 - SSL Settings 


3. Select Require SSL and then select Apply from the Actions pane. 
 


 
Figure 32 – Error 
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3.2 How to Enable SSL for Netspan on IIS 8.5 (Windows Server 2012 R2 
and Windows 8.1) 


3.2.1 Adding a Security Certificate 
1. Start Internet Information Services (IIS) Manager and select the server listed under the 


Connections pane. 


 
 


Figure 33 – select the server 
 


2. Select and run (double click) Server Certificates. 
 


 
Figure 34 - Add a Security Certificate 
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3. Add a certificate using the options in the Actions pane. The following example uses Create 
Self-Signed Certificate.  


 
Figure 35 - Specify name 


 


4. Name the certificate and select OK. 
 


 
Figure 36 - Server Certificate 
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3.2.2 Adding an HTTPS Binding 
1. Start Internet Information Services (IIS) Manager and select Default Web Site. 


 


 
Figure 37 - Default Web Site 


2. Under the Actions pane, select Bindings… 
 


 
Figure 38 - Add Site Binding 


 


3. Click Add, change Type to https, and then select the previously added SSL certificate. Click 
OK, and then click Close. 
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3.2.3 Accessing Netspan via SSL 
1. Use https://<server>/Netspan where <server> is the full server name. 


 


 
Figure 39 - Via SSL 


3.2.4 Forcing all Connections to Use SSL 
These instructions may be used to disable http access to Netspan and force use of SSL via https. 


1. Start Internet Information Services (IIS) Manager and select Default Web Site. 


 
Figure 40 - Default Web Site 


2. Select SSL Settings. 
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Figure 41 - SSL Settings 


3. Select Require SSL, and then select Apply from the Actions pane. 
 


 
Figure 42 – Error 
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Appendix A – Browser Warnings Caused by Self-Signed 
Certificates 


On the public internet, https with a certificate is used for two purposes: 


1. Encrypted communication to a web server. 
2. Secure identification of a webserver via a certificate issued by a trusted certificate authority.  


Https with a self-signed certificate provides encrypted communication to the web server.   


Browsers display warnings when visiting a site that is secured using the self-signed certificate to warn 
the user that the site may or may not be the one they are expecting to visit.  These warnings have an 
option to proceed to the site. 


 
Figure 43 – Warnings 
 


The warnings can be prevented when visiting the site in the future as follows: 


3.3 Internet Explorer 9 
1. Click Continue to this website (not recommended). 
2. Click Certificate error. 


 







 Netspan IIS Installation and Configuration Guide  


 
Page 34 Commercial in Confidence UGD-D00643 Rev F 


 
Figure 44 - Certificate Error 
 


3. Click View certificates. 
 


 
Figure 45 - Certificate Information 
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4. Click Install Certificate. 
 


 
Figure 46 - Certificate Import Wizard 
 


5. Click Next. 
 


 
Figure 47 - Certificate Store 
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6. Click Place all certificates in the following store. 
7. Click Browse. 
8. Select Trusted Root Certification Authorities. 
9. Click OK. 
10. Click Next. 


 


 
Figure 48 - Certificate Import complete 
 


11. Click Finish. 
 


 


Figure 49 - Warning 
 


12. Click Yes. 
The warning message will not be shown after the browser is restarted. 
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3.4 Firefox 4 
1. Click I understand the Risks. 
2. Click Add Exception. 
3. Click Confirm Security Exception. 


 


 
Figure 50 - Firefox Security Exception 


3.5 Google Chrome 
1. Import the certificate into the trusted certificate store using Internet Explorer. 
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Appendix B 
Revision History 


Revision Originator(s) Date Description 


Draft M Falik 21/10/2012 Initial Document 


Rev  A M Falik 31/10/2012 Updated with review 
comments 


Rev B M Falik 19/12/2010 Removed SR reference  


Rev C M Falik 17/02/2013 Updated &  Windows 8 
Installation 


Rev D M Falik 04/04/2013 Updates 


Rev E B Wijayaratne 


M Falik 


24/12/2013 Updates 


Rev F Danish Azam 


Veena 
Radhakrishnan 


08/10/2014 x Updated Purpose. 


x Removed the Verify 
Prerequisites section and 
added a reference to the 
Netspan Installation and 
Upgrade Guide. 


x Added the How to Enable 
SSL for Netspan on IIS 
8.5 (Windows Server 
2012 R2 and Windows 
8.1) section. 


Contact Information 
Customer Service Help-Desk for customer service emergency 


Airspan Networks have introduced the Airspan Tracker application to enable prompt and efficient 
Customer Support services. 


If you do not have an Airspan Tracker account, please obtain login credentials by filling-in the form in 
the main page "Register New Account". 


Worldwide Headquarters: 
Airspan Networks Inc. 


777, Yamato Road, Suite 310, 


Boca Raton, FL 33431, USA 


Tel: +1 561 893 8670 


www.airspan.com 


Feedback: 


To provide feedback on this document, please send comments to the following email address: 
documentfeedback@airspan.com 



http://tracker.airspan.com/

http://tracker.airspan.com/?register=true

http://www.airspan.com/
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Document Information  


Abstract 


This guide provides the workflows and step-by-step procedures to install SQL Server 2014 Express for 
use with Netspan. 


Revision History  


Revision Details Date Summary of Changes 


Issue 2.0 April 2015 Document updated to most recent template. 


Added Appendix B, How to Add Windows 
Authentication Users 


Issue 1.0 June 2014 Document created. 
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About This Document 


Purpose 


This guide provides the workflows and step-by-step procedures to install SQL Server 2014 Express for 
use with Netspan. 


Intended Audience 


This guide is intended for engineers who are responsible for managing the Netspan system. These 
engineers should have a working knowledge of Netspan. 


Document Conventions 


This document uses the following typographic conventions. 


Table 1. Typographic Conventions 


Convention Element 


Blue underlined text  Cross-reference links. 


Bold text Keyboard buttons and GUI elements. 


Command Command names or phrases. 


Computer output Text displayed by the computer. 


Hyperlinks Website and e-mail addresses. 


Danger 
Signifies a hazardous situation—if not avoided—will 
cause death or serious injury. Describes how to avoid 
it. 


Warning 
Signifies a hazardous situation—if not avoided—can 
cause death or serious personal injury. Describes 
how to avoid it.  


Caution 
Signifies a hazardous situation—if not avoided—can 
void the product warranty, and cause property 
damage. Describes how to avoid it. 


Important Provides necessary information to explain a task. 


Note Provides additional information. 


Tip Provides helpful hints. 


Document Organization 


Chapter Contents 


1 Verify Prerequisites 
Provides details of the prerequisite software that you should 
ensure is installed before you attempt to install SQL Server 
2014 Express. 


2 SQL Server 2014 Express Installation Details the process for installing SQL Server 2014 Express. 



http://www.airspan.com/
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Chapter Contents 


A Appendices 


The appendices in this document cover: 


 How to Change SQL Server Authentication 


 How to Add Windows Authentication Users 


 Abbreviations 


Related Reading 


The following documents contain related information: 


 UGD-D00739 Netspan SQL Server 2014 Standard Installation Guide 


This document describes the procedures for installing and configuring SQL Server 2014 
Standard for use with Netspan. 
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Customer Care Help Desk 


Airspan’s Customer Care Help Desk offers prompt and efficient customer support services. 


Note: To avail Airspan’s Customer Care Help Desk support, you must be a registered user and must 
have a valid support contract. To register, click here and fill the Registration form. 


To create and update issue logs, send e-mails to Customer Care Help Desk. Once you submit your 
issue, the system generates a new issue and sends an issue number for your reference. The system 
uses this issue number to categorize and store e-mails under the appropriate issue. 


To help Customer Care Help Desk identify your issue, include the issue number and your Customer 
Care Helpdesk account details in all further communications. 


Main Operations 


Airspan Communications Ltd.  


Capital Point  


33 Bath Road  


Slough, Berkshire  


SL1 3UF, United Kingdom  


Tel: +44-1895-467-100  


Worldwide Headquarters 


Airspan Networks Inc. 


777, Yamato Road, Suite 105 


Boca Raton, FL 3341-4408, USA 


Tel: +1 561 893 8670 


Airspan India 


Airspan Networks India Pvt Ltd 


1203, 12th Floor 


Ambience Court 


Sector 19D, Vashi 


Navi Mumbai- 400703 


Tel: +9 12265324999 


 +9 12265304999 


Airspan Encourages Comments 


Airspan welcomes any feedback and suggestions that help to improve the quality of the documentation. 
Send your feedback to documentfeedback@airspan.com.  


  



https://support.airspan.com/SignUp.jsp?account=airspan

mailto:helpdesk@airspan.com

file://fs11/dfs/PLM/Docspan_Repository/Veena/All%20Documents/Templates/Current%20Templates/Document_Template/documentfeedback@airspan.com
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1 Verify Prerequisites 


This section describes the prerequisite software that you should ensure is installed before you attempt 
to install SQL Server 2014 Express. Without these prerequisites, your system will not be fully 
operational. 


1.1 Verify Software Requirements  


It is recommended that you always install the latest service pack of the selected SQL Server engine. 
Netspan verifies the SQL version during installation and checks for the minimum supported version. 


Note: Netspan Server should be installed on a dedicated server machine. A configuration where 
Netspan shares the database on the Netspan Server with another application is not supported. 


 


Note: Netspan requires an English version of the Operating System (OS), keyboard and SQL Server. 


 


Caution: You are responsible for checking the Microsoft web site for the latest service packs and hot 
fixes. 


1.2 Netspan Prerequisite Installation Order 


The order in which you should install the prerequisite software is as follows: 


1. Install the software environment (i.e. the OS with the latest service packs). 


2. Install IIS if it is not already installed. 


3. Install the .NET Framework if it is not already installed. This is required for all OS other than 
Windows Server 2008 64 bit (the .NET 4.0 client profile is already installed as part of the OS). 


4. Install SQL Server. 


Note: When you perform a clean install of Netspan on a machine that has never had Netspan 
installed before, it is imperative that you install the prerequisites in the correct order. 
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2 SQL 2014 Express Edition Installation 


Download Microsoft SQL Server 2014 Express Edition with the latest service pack(s) from the 
Microsoft Download Center: 


http://msdn.microsoft.com/en-us/library/dn434042.aspx 


Select the With Tools version to match your OS (32-bit or 64-bit), e.g.  


ENU\x86\SQLEXPRWT_x86_ENU.exe (for 32-bit) 


ENU\x64\SQLEXPRWT_x64_ENU.exe (for 64-bit) 


2.1 Database Engine Installation 


To install the database engine: 


1. Run the relevant .exe to launch the installation wizard and wait for the SQL Server 
Installation Center screen. 


2. Select New SQL Server installation. 


3. On the License Terms screen, accept the license terms and click Next. 


4. The Install Setup Files screen is displayed. This step should complete automatically without 
any user interaction.  


5. The Install Rules screen is displayed. This step should complete automatically without any 
user interaction 


6. The Feature Selection screen is displayed (see figure 1). In the Features list, select 
Database Engine Services, Management Tools - Basic and Management Tools - 
Complete. Click Next. 


Note: The Management Tools - Basic and Management Tools - Complete options may 
not always be shown. If shown, you should select them. 


 


Figure 1: SQL Server 2014 Setup, Feature Selection screen  


 



http://msdn.microsoft.com/en-us/library/dn434042.aspx
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7. The Instance Configuration screen is displayed. Select Named Instance and enter a 
suitable name for your SQL Server instance. Click Next. 


 


Figure 2: SQL Server 2014 Setup, Instance Configuration screen  


 


 


8. The Disk Space screen is displayed. Assuming adequate disk space is available, this step 
completes without any interaction. If the required disk space is not available, you will need to 
create more space, click Back and allow the step to re-run. Click Next when you are ready to 
proceed. 


9. The Server Configuration screen is displayed. On the Service Accounts tab, select the 
following options: 


a. SQL Server Database Engine 


b. SQL Server Browser 
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Figure 3: SQL Server 2014 Setup, Server Configuration screen, Service Accounts tab  


 
 


10. Click the Collation tab. Confirm the default option of Latin1_General_C1_AS and click Next. 


 


Figure 4: SQL Server 2014 Setup, Server Configuration screen, Collation tab  


 
 


11. The Database Engine Configuration screen is displayed. On the Server Configuration tab, 
select Mixed Mode and provide a user name and password. 


In the Specify SQL Server administrators panel, click Add. The Select Users, Computers, 
Service Accounts or Groups dialogue is shown. Add at least one Windows account or 
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group with administration rights. It is recommended that you prepare in advance a group of 
Windows users defined specifically to administer this SQL Server. The default is to add 
<machineName>\Administrators. When added, the group appears in the Specify SQL Server 
administrators panel as BUILTIN\Administrators (Administrators). 


Note: If you have any difficulties in selecting the BUILTIN/Administrators option, click 
Advanced in the Select Users, Computers, Service Accounts or Groups dialogue. Select 
the machine name in the From This Location entry and click Find Now. From the resulting 
list, the appropriate Administrators option can be selected. Once selected, it should appear 
as BUILTIN\Administrators (Administrators). 


 


Figure 5: SQL Server 2014 Setup, Database Engine Configuration screen, Server Configuration tab  
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12. Click the User Instances tab. Clear the option Users are allowed to run a separate 
instance of the database engine.  


Figure 6: SQL Server 2014 Setup, Database Engine Configuration screen, User Instances tab  


 


 


13. Leave the settings on the Data Directories and FILESTREAM tabs as the defaults and click 
Next. 


14. The Error Reporting screen is shown. Assuming there are no errors, click Next. 


15. The Feature Configuration Rules screen is displayed. This step should complete without 
any user interaction. 


16. At this stage, the installation should start and continue to completion. Progress is shown on 
the Installation Progress screen. 
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17. When the installation finishes, the Complete screen is shown. Click Close to exit the 
installation wizard.  


Figure 7: SQL Server 2014 Setup, Complete screen  


 


 


18. The SQL Server 2014 Express installation with Management Studio options is now complete. 
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A How to Change SQL Server Authentication 


To allow for the installation and use of Netspan with SQL Server Authentication Mode, you must 
ensure that the SQL Server Authentication is set to SQL Server and Windows Authentication 
mode on the SQL Server Security Properties configuration window and that there is an SQL Server 
Authentication Login created with a role of sysadmin.  


This appendix describes the process for configuring the SQL Server Authentication Mode. 


Note: SQL Server might need a restart after making these changes. 


How to Set SQL Server Authentication Mode 


1. Open the SQL Server Management Studio Object Explorer. Right click on the appropriate 
server entry and choose Properties from the popup window. This opens the Server 
Properties window. (If the Object Explorer panel is not visible, open it using the View menu 
option.)  


2. Select the Security page. 


3. Select the option SQL Server and Windows Authentication mode and click OK. 
 


Figure 8: Server Properties screen  
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How to Add SQL Server Authentication Login 


1. Open the SQL Server Management Studio Object Explorer. 


2. Right click in the Security > Logins folder and select New Login. 


3. On the General page, enter a Login name, select the SQL Server Authentication and 
Enforce Password Policy options, and clear the User must change password at next 
login and Enforce password expiration options.  


 


Figure 9: Creating SQL Server Authentication Login 


  


 


4. Select the Server Roles page. 
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5. In the Server roles list, select sysadmin. Click OK. The login setup is complete. 
 


Figure 10: Add sysadmin role to Login 
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B How to Add Windows Authentication Users 


This appendix describes the process for adding a Windows Authentication user once SQL Server has 
been installed. 


1. Open the SQL Server Management Studio Object Explorer and connect through an 
existing SQL Server Authentication account. (If the Object Explorer panel is not visible, open 
it using the View menu option.) 


2. Expand the Security folder tree and right click on the Login folder. Choose New Login from 
the popup menu.  


 


Figure 11: New Login option 


  
 


3. This opens the Login - New window.  


 


Figure 12: Login – New window 
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4. Click the Search button associated with the Login name field. The Select User or Group 
window is displayed.  


 


Figure 13: Select User or Group window 


  
 


5. Click Locations. 


6. In the Locations window, select Entire Directory and click OK.  


 


Figure 14: Locations window 


  
 


7. You are returned to the Select User, Service Account, or Group window. In the Enter the 
object name to select field, enter the login name for the user you are creating. Click Check 
Names to ensure that the user name is valid, and OK to confirm.  


 


Figure 15: Select User, Service Account, or Group window 
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8. You are returned to the Login - New window. In the Select a page panel, click Server Roles. 
Select the sysadmin option to assign the system administrator role to the user you are 
creating. Click OK.  


 


Figure 16: Server Roles window 


  
 


9. Verify that the login you have created works as expected by connecting to the server using 
the new Windows Authentication account.   


 


Figure 17: Connect to Server window 
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C Abbreviations 


Term Expansion 


IIS Internet Information Services 


OS Operating System 


SQL Structured Query Language 
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